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Usability testing of web site design and content: two case
studies
by Heather Lum
At one of the companies where I used to
work, I had the opportunity to participate
in two usability testing efforts. The teams I
participated on learned a lot in both cases.
One usability study was a low-cost effort,
and the other received additional funding
beyond the costs associated with staffing.
I’ll describe each case and explain what we
did to perform the usability test, what we
learned, and how the results were (or were
not) applied.
Low-cost example
My team’s project was to usability test the
content model for an intranet site that we
were also developing. The site would make
new and existing customer service policies,
procedures, product information, and contact information available to customer ser-

vice staff from a single portal. It would be
integrated with a new customer service application that was being designed to model
a new workflow process as well as replace
numerous legacy systems.
With the old systems and workflow, when
customer service representatives and support staff wanted to reference policy or procedure-related documentation, they had to
access an overwhelming combination of
mainframe-based online documentation,
paper manuals, sticky notes, mainframebased news groups, and emails. The information within each of these repositories was
disorganized, often outdated, and frequently categorized based on the legacy
system in existence at the time the documentation was first written.
The intranet site portion of project received

Bringing the user into your work
by Heather Lazzaro
One of the most important maxims in technical writing is “know your audience.” But,
how can you be sure that you really know
them? Conduct some basic user and task
analysis to understand what documentation type, format, and content will work best
for your users. Before you write about even
one screen, you should be able to summarize the characteristics of your audience and
understand what tasks they will perform
with the product that your company is creating. Consider the following questions
about your audience. Keep in mind that this

is just a sampling of questions; you can
come up with many more depending on the
particular product you are documenting.
User Profile Questions
n What is their average age and education level?
n

Are they mostly male or female?

n

Do they have any biases toward technology?

n

How long have they been in their current jobs, and what kinds of positions
did they have previously?

no specific funding beyond staffing, so the
cost was limited to the number of person
hours it took to complete each phase of the
project.
What we did
Our team was made up of information developers, an application developer, business analysts who had been customer service representatives, and support staff who
authored customer service policy and procedure documentation.
After researching, tracking, and analyzing
every conceivable repository of existing
customer service documentation in a
spreadsheet, our team used the information
to come up with an initial content model for
the intranet site. Our content model
included categories of information with
(Continued on page 9)
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Presidents Column
by Heather Lum
The survey results are in. Thanks to those
of you who responded, the Pittsburgh chapter board has learned much more about what
topics are of interest to you, when and where
you would like to have meetings, and how
much you are comfortable paying for food
and drink.
The results
Meeting topics: The survey asked members
to identify topics that would interest them
enough to attend an STC meeting. Each of
the popular topics listed below was chosen
by over 50 percent of respondents. Each
person also indicated the three topics that
were most important to him or her. Not surprisingly, these topics were among the most
popular.
n

Professional development (1)

n

Project management strategies (2)

n

Tools and technology: publishing (3)

n

Information design

n

Tools and technology: general Web
development

Meals and costs: The survey asked members whether they would attend meetings
where hors d’oeuvres were served in lieu
of a meal. It also asked members to indicate
how much they were comfortable paying
for food and drink at a meeting.
Everyone said either that they would like
hors d’oeuvres, or that it didn’t make any
difference to them. The majority (52 percent) said they were comfortable paying
between $10 and $15 for food and drink at a
chapter meeting.
Meeting locations and times: The survey
asked members whether they would attend
meetings held at times other than a weekday evening. Of those who responded to
the question, 56 percent said they would
attend a weekday lunchtime meeting, and
48 percent said they would attend a weekday breakfast meeting. There was some interest in weekend meetings as well.

One question targeted members who rarely
or never attend chapter meetings, asking
them why they don’t attend. Of those who
responded to the question, 37 percent cited
inconvenient meeting times, and 22 percent
cited inconvenient meeting locations.
Planned changes
Meeting topics: The topic results were surprising in some instances. “Online help
authoring” appears to have been done to
death, because the topic ranked near the
bottom in interest and importance. Topics
such as “Editing” and “Single-source documentation” were also among the least popular.
While most of the meetings for the 20002001 year are already planned (and include
a mix of very popular and less popular topics), the chapter board will use the survey
results to plan meetings for the next program year.
Meals and costs: Most people indicated
they are open to or even prefer meetings
without meals, so we plan to try a few hors
d’oeuvres-style meetings over the next few
months. The November meeting dinner was
canceled due to lack of response, but three
times as many people as those who RSVP’d
attended the presentation portion of the
meeting, where they enjoyed the finest in
soda, chips, and pretzels. The cost to the
chapter of providing hors d’oeuvres at little
or no cost to attendees is significantly less
than the cost of serving dinner and charging attendees $10 to $15. Plus, light hors
d’oeuvres can be served anywhere, which
opens up additional possibilities for meeting locations.
Meeting locations and times: Many people
said that meeting times and locations are
not convenient and that they are interested
in meeting during the weekday over breakfast or lunch. While most of the remaining
2000-2001 meetings are already scheduled
for weekday evenings, we will plan some
breakfast and lunch meetings for the next
program year.
(Continued on page 4)
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High-Falutin Ideas (And Business) At 10th Annual Tech
Fest
by Jon Szish
Samuel Morse? The father of e-commerce?
That was Al Pinkus’ bold suggestion at the
10th annual ITEC, or Information Technology Exhibition and Conference, held Oct.
25 and 26 at the David L. Lawrence Convention Center.
“Before Morse, the best you had were signal flags,” said Pinkus, vice president of
Adonix, Inc., which is a French systems
developer with offices in Sewickley. “Everything moved at the speed of the wind.”
The comment probably wasn’t too far from
the truth, considering how the electronic
alphabet otherwise known as Morse code
opened the door to so many new technologies after its first use in 1844.
Pinkus’ thoughtful juxtaposition was emblematic of the high-tech idea exchange at
ITEC, where ideas flowed freely. The tech
fest drew hundreds of area professionals
together to ponder the wares and brochures
of 130 vendors of high-tech products and
services - and in some cases, free giveaways.
In addition, there were plenty of seminars,
like the one Pinkus presented that was titled,
“Does Your e-Business Backbone Need a
Chiropractor?”
For the tech writer, there was much buzz
about XML, an acronym for “extensible
markup language,” the now-contagious format for storing document content that also
allows for meaningful description of the
content. Companies such as Treehouse
Software Inc. of Sewickley gave a seminar
titled “Catch the XML Wave,” which explored the company’s Tamino database
management system. Treehouse billed the
database as being the first information
server to store XML data without converting it into other data structures and as being able to integrate legacy data sources
into XML documents.
Westlake Internet Training, a Virginia computer training company with offices in Pitts-

burgh, told tech professionals in a seminar
about the pros and cons of the most common Web-to-database integration technologies, such as Perl, ASPs, ColdFusion
and JSPs.
Imark Communications, the event management company that produced the conference, puts on about 60 ITEC shows nationwide each year. An Imark spokeswoman
said the company doesn’t release turnout
numbers for its conferences, which are designed to generate exhibit-floor traffic between tech professionals and vendors.
Perhaps several of those very same vendors perked up when the state’s chief Information Technology supervisor said
Pennsylvania buys $360 million in new technology products each year.
That tidbit came from Charles F. Gerhards,
deputy secretary for Information Technology in the Governor’s administration office
and one of ITEC’s keynote speakers. He
told how Gov. Tom Ridge has tried to turn
around a low-tech state - one of three states,
in fact, that had no Web presence when
Ridge took office in 1995. But with a frenzy
of refocus in recent years, the state’s Web
site clocked its billionth visit in August.
Some entreprenurial tech writers might appreciate how another state Web site walks
a future business owner through the process of launching a business. Because
Ridge wants to promote high-tech growth,
he helped launch the web site http://
www.paopen4business.state.pa.us, a site
which allows users to fill out state business permits online.

Since this site was launched in October 1999,
nearly 8,700 prospective businesses have
registered with the state online, Gerhards
said. In fact, just 11 minutes after the state
launched the site, a Canadian bakery company chose to locate in Pennsylvania because of the Web site, which helped the
company discover the state’s proximity “to
a lot of milk and eggs,” Gerhards said, referring to the state’s strong agriculture industry.
Perhaps more than informational seminars,
this year’s ITEC showed what a high-tech
community Pittsburgh has become. Representatives from local companies such as
Treehouse Software, Universal Information
Systems (of Plum), Enterasys Networks (of
Pittsburgh), and Marconi (British-owned
but with offices in Warrendale) showed
their wares and gave demonstrations. There
were plenty of national ones as well, such
as Microsoft, which demonstrated its new
server application, Microsoft Exchange
2000, which the company billed as one of
the first in a wave of new server applications built to take advantage of the power
and reliability of the Windows 2000
server.3
If you go next year ...
Next years Pittsburgh ITEC convention is scheduled for Nov. 28 and
29, 2001, at the Greater Pittsburgh
Expo Mart in Monroeville. For information, call (503) 968-1123 or
check out Imarks Web site at
http://www.goitec.com

Ideally, Gerhards said, the Web site will one
day enable users to apply for all state permits and then link to their local county and
municipal Web site to fill out those permits
online. But in that case, an entrepreneur
will be limited by his home municipality’s
online presence (or lack thereof) to fill out
the forms.

PAGE 3

BLUE PENCIL

SOCIETY FOR TECHNICAL COMMUNICATION

Presidents
Column
People News

New Members
Gerald Ellefson
Julie Hoke
Jordynn Jack
Ryan Little
Joseph Spahr
Jennifer Lynn Zolak
Transferred in
Linda Rachul-Rymniak

(Continued from page 2)
Location is a tricky issue, no matter what
time a meeting is held. Meetings are usually located downtown or in Oakland, both
central work areas in Pittsburgh. Several
respondents requested that the chapter try
to hold a few meetings a year outside of the
city in, for example, the Monvroeville area.
While weekday breakfast or lunch meetings
would probably not work in these outlying
locations, weekend meetings or weekday
meetings scheduled later in the evening
could.
Thanks again to everyone who took the
time to complete the survey. The first 10
members to respond received $10 gift certificates to Barnes & Noble, and all participants received coupons for a $5 discount
on an upcoming chapter meeting of their
choice.
More information is online: For the complete survey results, visit the STC, Pittsburgh chapter Web site at http://
www.stcpgh.org. 3

Chapter Membership
211

TechComm

Total STC Membership

Technical Writing

23,004
Society for Technical Communication
Pittsburgh Chapter
P.O. Box 133
Pittsburgh, PA 15230
Contact: Heather Lum
Phone: 412-243-3151
hlum@pobox.com
National Office
901 North Stuart Street
Suite 904
Arlington, VA 22203-1822
Phone: 703-522-4114
Fax: 703-522-2075

PAGE 4

Experienced Technical Writer
Experienced Researcher
• Research Proposals
• Grant Proposals
• Contract Proposals
• Research Reports
• Articles
• Monographs
• Training Materials
Telephone: 412-343-2508
Telefax: 412-531-4796
blieberman2@compuserve.com

Editorial Calendar
January, 2001  Presenting your portfolio. Deadline 12/15/00.
February, 2001  Java technology, part
1 (Java programming language). Deadline 1/15/01.
March, 2001  Java technology, part
2 (Components). Deadline 2/15/01.
April, 2001  Indexing. Deadline
3/15/01.
May, 2001  Writing for the World Wide
Web. Deadline 4/15/01.
Summer, 2001  Annual conference
wrap-up. Deadline 6/15/01.
Advertisements
STC Pittsburgh members may place a free
business card-sized (2 1/4 inch x 3 1/2
inch) ad for their products or services in
each issue; non-member cost is $25 per
ad, per issue. For larger ads, please contact the editor. Ads received by the deadline will be included in the next months
issue.
Guidelines
Send your submissions to:
Nancy Ott
Editor, Blue Pencil
117 West 8th Street
Pittsburgh, PA 15215
412-667-4985 (W), 412-784-0254 (H)
nott@transarc.com
Electronic submissions (email or diskette)
are preferred. I can accept most word processing and graphics file formats and can
scan hard copy artwork. Contact me if
you have any special requirements. 3
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Word Smith: Grappling with graphics
by Bob Mohr
Perhaps no other area in Word causes more
grief than graphics. Fortunately, the graphics monster can be tamed.
With a little practice, you’ll find you can do
with Word’s built-in graphic capabilities, the

WordArt objects are handled in much the
same way as other Word objects. They can
be dragged and dropped, resized by dragging a resizing handle, and rotated. And
best of all, they can be modified with colors, shadows, fills, and textures.
A WordArt object is a great way to mark a
document as a DRAFT version while adding a little pizzazz to it. Used this way, the
WordArt object appears as a watermark.
Watermarks are often used to subtly display a graphic element in your document.
This can be a note such as “Draft” or “Confidential.” The result could look something
like this:

the margin of the document.)
4.

Select an object style and click OK.
The WordArt text box is displayed.

5.

Replace the text prompt with D R A F T
and choose an appropriate font. You
needn’t be too concerned with the font
size now as the object can be resized
using the sizing handles.

6.

Click OK to close the box. The
WordArt object is displayed.

7.

Place the WordArt object on the page
and resize it to suit by dragging the
sizing handles. This is also the time to

same things you can do with many dedicated graphic programs. The following examples illustrate some of the possibilities.
Rather than get bogged down here with a
discussion of the intricacies of Word’s text
and graphic layers, let me offer a few rules
of thumb concerning graphics that have
proven valuable time and again:
n

Put graphics in text boxes whenever
feasible. Text boxes offer finite placement control.

n

Refrain from embedding graphics in
documents—especially if the document is large or contains many graphics. Always link your graphics.

n

Refrain from using graphics in BMP
format. BMP files are excessively large.
The same visual quality can be
achieved with GIF or JPG versions of
the same graphic at a fraction of the
size.

WordArt
This is a feature that can be used as many
ways as you care to imagine. It’s great for
newsletters, banners, CD labels, jewel cases,
business cards, T-shirt transfers—all sorts
of things. It’s also easy to use.

Here are the steps for adding such a
WordArt object:
1.

Create the document as you normally
would.

2.

Double-click on the header area to display the header view.

3.

Choose Insert > Picture > WordArt.
The WordArt object gallery is displayed. (The vertical objects are good
choices for displaying text vertically in

change the fill color of the letters. The
example above used a light green color
that is easily seen on screen without
being obtrusive and prints on a black
& white printer as a very light gray.
(An easy way to work on a WordArt
object is to display the WordArt
toolbar and use the available icons.)

(Continued on page 6)
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Word Smith: Grappling with graphics
8.

menu and select a Microsoft Word Picture. Once in the Picture Editor, remember to adjust the picture boundaries
using the Edit Picture toolbar before
closing the editor.

Click Close on the header toolbar. The
WordArt object is displayed on every
page that the header appears on.

Words Drawing Tools
Here’s a very simple example of a diagram
created with Word’s drawing tools and symbols from the Wingdings character set:

n

To draw a straight, angled line (in 15
degree increments), hold down the
SHIFT key while drawing the line.

This method has several disadvantages:
n

Images captured this way are converted to BMP format and may range
from 50,000 bytes to well over 200,000
bytes. Embedding several of these in
one document will bloat the file size
dramatically.

n

Graphics pasted “inline” this way are
difficult to reposition.

n

If the screen you captured changes,
you have to recapture it, delete the previously pasted image, and paste the
new version in its place. If that same
graphic appears in multiple places or
multiple documents, this could be a
very time-consuming task.

A better way is to use a third-party graphics program capable of doing screen captures and saving the captured image to either JPG or GIF format. (My favorite tool for
this is Paint Shop Pro by Jasc Software;
http://www.jasc.com.)
With 3-D shadows, dozens of predefined
AutoShapes, colors, and textured effects,
diagrams can be far more elaborate than this
simple illustration. The best way to learn
about the drawing tools is by using them.
There are some very good reasons why you
should become familiar with Word’s drawing tools:
n

You can combine clipart, photo pieces,
drawing elements, WordArt, and
AutoShapes to create very colorful and
elaborate graphic displays.

n

Text can be added to many of the
AutoShape objects.

n

You can “layer” AutoShapes on top of
one another to create interesting effects.

n

Multiple objects can be grouped together as a single object for more control.

Drawing Tool Tips
n Resist the temptation to start drawing
randomly on the page. Instead, use the
Insert > Object option from the main
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n

n

n

To draw a perfect circle, hold down the
SHIFT key while drawing with an ellipse object.
To copy an existing object, press CTRL,
click on the object, and drag the copy
to the new location.
You can nudge the location of an object using the CTRL key in combination with the arrow keys.

Screen Captures
There are several ways to capture screen
images and include them in documents.
Here’s the worst:
1.

2.

With the screen you want to capture
displayed, press ALT+PrintScreen.
This puts a copy of the active window
into the Windows Clipboard.
Open the Word document, position the
insertion point, and choose Edit >
Paste from the main menu. The captured image is pasted into the document.

Steps to capture and use screen images:
1.

Display the image to be captured.

2.

Capture the image using the graphics
program of your choice.

3.

Save the image to a GIF file (if less than
256 colors) or to a JPG file (if more than
256 colors).

4.

Position the insertion point in your
Word document and create a text box
to hold the graphic.

5.

Insert the graphic as a “picture from
file” into the text box using a link. Do
not check “Save with document.”

This method offers several advantages:
GIF and JPG files are typically much smaller
in size than images copied from the Clipboard.
GIF and JPG files are more convenient when
converting your documents to Web
pages.
Text boxes make placement of the graphic

PITTSBURGH CHAPTER

simpler and easier.
If the screen you captured changes, you
still have to recapture it, but you don’t
have to replace it in your document.
The link does that for you no matter
how many times the graphic changes,
the latest version captured will always
be displayed.
Here’s a quick way to see the filename of a
linked graphic without having to open the
Link dialog box: Select the graphic and press
SHIFT+F9. This displays the hidden field
code for the link and the path and filename
associated with the graphic. Press
SHIFT+F9 again to toggle back to the
graphic.
So, stop grappling with graphics. Experiment with these techniques and enhance
your documents with graphics.
This article was excerpted from the e-book,
The Elements of Word, available at http://
www.writemohr.com.3
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Enter the worst
manual contest!
Just a reminder for the holiday season, if —
no, when — all else fails, read the manual.
Have you ever been so frustrated with a
manual or set of instructions that you
cursed the author and wished you had never
bought the product? Do you remember the
last time you used Help on your computer
and every click of the mouse led to a new
set of decisions?
Does this sound familiar? How about $500 for
your frustration? Technical Standards, Inc. (TSI),
a Southern California documentation services
company, is offering $500 for the winning entry
in their ‘Worst Manual Contest.’
Send a manual or set of instructions that is
hard to understand, poorly written, or just
plain wrong. Send it if it has bad grammar,
too much legalese, is poorly translated, or
has missing steps. If it is the worst entry,
you will win $500.
“We thought we would have fun with this
contest. Everyone has had trouble with a
manual,” says Michelle Wier, Director of
Operations of Technical Standards, Inc.
“That’s why we started our company.
People like products they understand how
to use, and good technical documentation
reduces the need for technical support.
That’s why good manuals are so important.”

Upcoming events
December 2000
December 7 — PittMark meeting
7:00 PM in the auditorium of the Software
Engineering Institute, 4500 5th Avenue, in
Oakland.
Dan Ketelaar, What We Wish We’d Thought
Of Before We Started The Springhouse
Project.
Bill Lewis, XSLT and the BizTalk Mapper.
December 9 — STC holiday party
Join your friends from STC at the Schenley
Park ice skating rink for some winter fun!
See page 12 for details.
January 2001
January 3 — PittMark meeting
Paul Cunningham, XML and Intelligent
Agents.
January 16 — STC chapter meeting
Monica Cellio and Deanna Rubin, How to
Write API Documentation.
PittMark is the Pittsburgh area XML/SGML
user’s group. More information about
PittMark can be found at http://
www.pittmark.org. Meeting times and dates
are subject to change with notice; check the
PittMark web site for the latest information.3

You don’t have to send the whole manual;
excerpts of the worst parts are okay. The
deadline for submissions is January 15, 2001,
so check those holiday gifts for potential
entries. Entries must be in English. For
complete contest rules, see the TSI Web
site at http://www.tecstandards.com.
Technical Standards, Inc. specializes in contract technical writing projects, technical
writer staffing, and training. Since 1993,
TSI has provided writers and editors to the
high-tech community who produce printed
documents, online help, and Internet documentation. Technical Standards, Inc. is located in San Marcos, California. Questions?
Contact: Jim Desmond at 760-471-1819 or
jimd@tecstandards.com. 3
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November chapter meeting highlights: Creating XML
Documents with the tools you already have
by Nancy Carpenter, Chapter Secretary

documents more easily across desktop publishing packages. Initially the
document would import as plain text.
But as conversion packages become
available, or as you learn to write your
own conversions, you can use the tags
to create formatted documents in a variety of platforms. Arbor Text, for instance will create a reasonable Word
version, but it is still being refined.

November’s chapter meeting (held on November 16 at Clairvoyance Corp.) featured a
presentation by Alan Houser on creating
XML documents. Alan’s presentation is
available on the Web at http://
www.groupwellesley.com/papers_talks.htm.
Here is a synopsis of his talk.
Information Explosion
Publication is no longer done just in hard
copy. Since the 1980s, an electronic version often is issued, for instance, in on-line
help. Help files can be required in the most
unlikely devices – cell phones, palm pilots.
Recently, firms have begun to integrate
documents with databases in on-line ordering and other applications. As a result, we
can expect field support personnel to have
computer devices that allow them to place
orders (using a database) and open help
files.
This information explosion increases the
number of documents that we have to maintain. So, we have become interested in
single source publishing.
What Does XML Offer?
XML stands for Extensible Markup Language. Like html, it is a meta language that
can be used for web publishing, but with
one very important difference. XML allows
you to define the content, not just the format, of the document. This has several desirable effects.
n

n

n

The ability to identify the meaning or
content of portions of a document allows you to treat a document like a database. Using the content-defined
tags, we can easily extract portions for
other uses, making single-sourcing and
document maintenance easier.
XML can be used to publish in all newest media, including those that incorporate information entry into a database.
The content tags allow us to share
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content type. Avoid format overrides.
(Hint: In Word, to display the styles,
go to Tools/Options/View/Style Area
Width and set the style area width to 1
inch. The styles will be listed in the
left margin)
4.

So How Big A Deal Is This?
Very big! XML is being used widely in database applications. Most database software web sites have an XML site. And
Microsoft has invested huge resources in
preparing for XML use, which indicates
how big they think it will be.
Some Limitations
XML does not yet support hard copy printing. However, it appears to be easy to use
FrameMaker and Word and some other publishing platforms to prepare our printed versions, then generate an XML version for
on-line use.
You cannot nest XML tags. This means
that you can only sort on one tag, not on a
group.
You cannot assign values such as priority
or importance to a tag.
Not all web browsers can support XML,
but they are moving in this direction.
Internet Explorer 5.5 will do this, and others
are on the way.
How to Get Started
Analyze the content of your document.
1.

If you are not already using style templates, begin to do so.

2.

Choose meaningful names for paragraph styles. Put underlines, not
spaces, in the style names.

3.

Categorize the paragraph styles into
content types. See if you can apply a
unique paragraph style to a unique

5.

Check your publishing package to see
if it will save a document as XML. It
will not have the full capability of an
XML application, but is quite usable
and cost effective. FrameMaker with
SGML is the most powerful of these
packages. Here is how to do this:
n

In FrameMaker 5.5 and 6.0, just
save as XML.

n

In Word, save as RTF (rich text
format). Use an RTF-to-XML conversion utility. Some utilities include Upcast, Majix, and
Omnimark.

Pick a pilot application to demonstrate
XML to your firm.

If You Only Publish On-Line
For those who only prepare on-line copy
and do not need hard copy capability, Alan
recommends going right to an XML editor
such as Soft Quad XMetaL. Native XML
authoring tools have a lot more power than
conversions from desktop publishing platforms.
Here is What a Database/
Document Can Do
Alan showed specific examples of how you
could use Word or Frame to produce XML
output. For a cookbook, for instance, you
can put tags on the recipe, its ingredients,
and the preparation process. You sort the
recipes into a menu for the week, then generate a shopping list.
Now if we could only get someone to do
the shopping and cooking and cleanup, we
would all use XML! 3
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Usability testing of web site design and content: two case
studies
(Continued from page 1)
several levels of organization and crossreferencing.
Next, we prepared a simple usability test
using index cards. We worked with customer service supervisors to recruit test
participants from different lines of customer
service business, asking that they choose
a mix of experienced and inexperienced staff.
We gave our testers a pen, and three sets
of colored index cards:
n

Blue cards represented the main categories, or types, of information.

n

Yellow cards represented the actual information.

n

Green cards were blank so that testers
could create new main categories, new
information, or additional copies of information.

We asked testers to sit at a large table and
arrange the cards in an organization that
made sense to them. In the room with each
person was a proctor, who explained instructions to the tester and answered questions
as objectively as possible, and a silent
evaluator, who took notes on the tester’s
actions and articulated thoughts.
First we asked testers to order the blue
cards, of which there were about seven. If
they thought a main category was missing,
they could use a green card to create it. If
they thought a specific blue card didn’t
belong as a main category, they were asked
to discard it and explain why.
Next, we asked testers to arrange the yellow information cards under the blue category cards to indicate where they thought
each card best fit. If they thought a card fit
in more than one category, they could make
as many copies as they needed using green
cards. We asked them to number each green
card to indicate the second, third, etc., category where they would look for the information.

If testers wanted to create subcategories
under the blue category cards, we asked
them to use green cards and the pen to create the subcategories, and arrange any information they felt belonged in each subcategory by putting the applicable card(s)
under the green subcategory card(s).
There was no time limit, since the objective
was to learn how each tester understood
and mentally organized the information. We
encouraged testers to keep reorganizing the
cards as they needed to until they felt they
were finished.
What we learned
We learned that the main categories our team
delineated would work—the testers didn’t
suggest many changes to our model.
Testers tended to suggest the same subcategories, most of which we had also identified. However, we learned that there was a
great deal of variety in how people categorized information within the subcategories,
and we realized we would need a lot more
cross-referencing than we originally
thought. We also discovered that the verbiage we used to describe some of the topics on the yellow cards was not as meaningful to the users as it needed to be.

needed to on an ongoing basis.
The next phase of usability testing involved
having users navigate a prototype of the
site to find information so they could answer questions that arose from a set of defined customer service scenarios. This process was very similar to the “funded example” I describe next, so I will move on to
that case.
Funded example
My team’s project was to usability test the
content model, content, and navigation of
the company’s first Internet Web site prior
to its public release about four years ago.
The Internet site was targeted at several
user audiences, but we focused on the areas of the site that would be of interest to
healthcare consumers.
In addition to funding staffing for the
project, the company hired a marketing
research firm to recruit test participants who
(Continued on page 10)

Experienced users seemed to long for the
organization they were accustomed to, disorganized and illogical though it was. It was
apparent that reorganizing the information
so extensively would take some adjustment
on their part, but it would greatly ease the
learning curve for new employees. Experienced users did understand that it would
be much easier to fit new information into
the proposed model, and find it once it was
there, than it had been in the past.
How the results were applied
Our team applied the usability testing results to fine-tuning our site model and develop a working prototype site. Because
the team included the application developer
and decision makers on the business side,
so we were able to make full use of our findings, revising the content model as we
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Usability testing of web site design and content: two case
studies
(Continued from page 7)
met four categories of criteria we
established. The company paid each tester
$50 upon his or her completion of the
usability test. The effort cost about $7,500,
plus staffing costs for the number of person
hours it took to plan and conduct the test,
and analyze and report the results.
What we did
The usability testing team was made up of
information developers who worked in the
same department. We spent many hours
preparing instructions for participants, a
pre-test, the actual usability survey scenarios, a post-test, and the process we
would use to run the testing. We also set
up a lab with PCs devoted to the testing
efforts, and secured video equipment so
we could tape the proceedings.
We were careful not to use the word “test”
in any materials or conversations with participants because we didn’t want them to
think they were being judged or that there
were right or wrong answers. Instead, we
used the terms “usability evaluation” and
“participant.”
First, participants entered a welcome room,
where we greeted and briefed them, offered
them tea or coffee, and asked them to complete the pre-test. The pre-test was designed to gather demographic data, gauge
their level of Internet experience, and assess how they interpreted icons they would
encounter on the actual Web site.
Next, a proctor lead each participant to the
usability lab, where both sat in front of a
PC. We instructed participants to read each
scenario in the usability evaluation and use
the Web site to find answers to the scenario questions. We asked participants to
follow a think-aloud protocol if they were
comfortable doing so, which enabled us to
better document their thoughts and decision-making processes. The proctor took
notes based on what each participant said
and did, noting what links they followed to
find (or not find) information.
PAGE 10

Sometimes participants got stuck and asked
for help. Each proctor was trained to be
objective and not provide any answers or
much guidance, stressing instead that participants did not need to answer a question
if they had looked for information as long
as they would in real life. The search process was more important than the answers
participants ended up writing on their surveys.
When participants had finished the usability survey, they returned to the welcome
room, where they were given the opportunity to vent to the host or hostess, who
had not been their proctor. Participants
completed a post-test to measure their opinion of the Web site’s organization, ease of
finding information, attractiveness, whether
it generally met their expectations, and
whether they would actually use it in real
life. Once they had completed the post-test,
participants received their $50 and went on
their way.
What we learned
We analyzed the test results using the surveys, pre- and post-tests, and proctors’
notes, reviewed videotapes in some cases,
and wrote up an extensive findings report
that included lots of data and charts. Some
highlights of what we learned:
n

Most of the main categories of information and their icons worked, though
some could be clarified.

n

Graphics were too large, taking up the
entire first scrolling region in many
cases. While the graphics were pretty,
they did not provide real information.

n

The site was too text-heavy. Users
could not easily scan to find valuable
information among all the marketing
language.

n

In many cases, text links were not
worded clearly enough. In other words,
a phrase would be underlined, but the
verbiage didn’t make it clear what users would find if they followed the link.

This lead users down wrong paths in
many cases. Link text needed to be
more specific, not buried in the text,
and free of marketing jargon.
How the results were applied
Unfortunately, our team’s findings weren’t
applied, because the department responsible for the site and its content declined to
use our findings. The site was released with
very few changes. This was very surprising to us, especially considering the money
the company spent on testing. However,
our department was able to make great use
of the findings in future projects ranging
from intranet site design to online help structuring.
Heather Lum is a freelance technical communicator and information designer. She
is president of the Pittsburgh chapter of
STC. 3
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Bringing the User into Your Work
(Continued from page 1)
Task Profile Questions
n What types of software do they currently use, and how will your product
affect that usage?
n

What specific tasks do they need to
accomplish with your product?

n

What other non-technological tasks are
they responsible for and what time constraints are they working under?

There are many options for gathering the
answers to these questions – surveys, interviews, and site visits are just a few. Don’t
forget, this doesn’t have to be a time-consuming process. You can fit this research
into your schedule.
If you work for a software company, you’re
familiar with the early stages of application
development − that period when there isn’t
much to document. Instead of wasting your
time creating volumes of fiction about a
product that will change a million times before you even see a prototype, e-mail surveys to your potential audience or interview them. If there’s no way you can speak
to your audience directly, talk to Product
Managers, Customer Service employees, or
anyone else in your company who has di-

rect contact with your users. You may only
have time to meet with a few Product Managers, but that’s a start. Maybe the next
time around, you’ll be able to expand on
that research.
If you have the opportunity, site visits can
provide you with a wealth of information.
Observing your users in their work environments is probably the best way to really
understand how they interact with technology and what their documentation needs
are. Another option is to “shadow” Customer Service calls to learn what problems
your users are having with current products and to help you identify with your audience. After you hear users’ voices on the
phone, it’s hard to dismiss a design issue
or an unclear procedure as a “stupid user
error.”

this information into a formal report so that
you can refer to it later and so that other
employees can benefit from your work. If
you don’t have time to write a report, that’s
OK. At least you now have enough knowledge to confidently assert that, indeed, you
do “know your audience.”
Heather Lazzaro is an information designer at Highmark.3

Regardless of your method for gaining information and the extent to which you research, performing user and task analysis
ensures that you will create quality documentation. Without this analysis, you might
end up wasting time creating user manuals
or online help that your audience can’t or
won’t use.
Once you can answer all of your user and
task questions, it’s a great idea to compile

Online Professional Development for Technical Writers
Are you interested in furthering your career potential and developing your skills in
the latest technologies? Worried about the high cost of education and missing work
to learn?
With three-month online courses on topics ranging from Professional Technical Writing
to XML Authoring, you can learn at your convenience without spending a lot of
money!
Visit www.online-learning.com to find out more about the payback of XML skills
for technical writers and to get more info on our courses. New sessions start monthly...
www.online-learning.com
Note - STC members receive a 20% discount if they mention their membership upon registration.
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Holiday Ice Skating Party!
Come and join us for a jolly holiday afternoon! The STC Pittsburgh’s 2000 holiday
event is a skating party on Saturday, December 9 at the Schenley Park Skating Rink
from 1:30-3:30. Thrills and spills on the ice
will be followed by refreshments — food
and lots of hot drinks! — in the nearby
home of our chapter vice president, Mary
Ecsedy.
The Schenley Park Skating Rink is a winter
playground that offers fun for the whole
family. Admission is $3.50 for adults and
$2.50 for children under 18; skate rental is
$2.00.
Schenley Park lies between Oakland and
Squirrel Hill; there are signs to the skating
rink throughout the park. A map of this
area (with directions from CMU) is available at http://econ.gsia.cmu.edu/
Freshman_Seminar/rink_directions.htm.

P.O. Box 133
Pittsburgh, PA 15230

December, 2000

Usability
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There’s nothing better after fun on the ice
than thawing out and relaxing with friends.
Mary Ecsedy and her husband Don are
hosting refreshments after the skating party
(or you can come just for refreshments if
you don’t want to skate). To get there from
the skating rink, take Overlook Drive to
Greenfield. Turn left onto Greenfield, and
turn right immediately at the light onto Panther Hollow Rd. Continue for approximately
100 yards and turn left onto Beacon St.
Continue for two or three more blocks to
Wightman. The Ecsedy residence is on the
right-hand side of Beacon St. just past
Wightman, at 5630 Beacon St., between
Wightman and Murray Ave. Parking is
available on the street.
See you there! 3

Date: Saturday, Dec. 9, 2000
Time: Skating 1:30-3:30 PM , Refreshments 3:30-5:30 PM
Location: Schenley Park Skating Rink
(412-422-6547), and the Ecsedy
residence, 5630 Beacon St. in Squirrel
Hill (412-422-0213)
Cost for refreshments: $5 singles, $7
couples, $10 family
RSVP: By Friday, December 8 to
Darlene Mullenix (412-288-8676 or
dmullenix@federatedinv.com)
Pay at the door or mail to:
Darlene Mullenix, Meeting Coordinator
c/o STC Pittsburgh
P.O. Box 133, Pittsburgh, PA 15230
Make checks out to STC Pittsburgh. If
you do not cancel your reservation by
December 8, you will be charged.

